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Safety Information 

Important Information 

Read these instructions carefully before trying to install, configure, or operate this 
software. The following special messages may appear throughout this bulletin or 
on the equipment to warn of potential hazards or to call attention to information 
that clarifies or simplifies a procedure. 

The addition of either symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists that will result in personal injury if the instructions are not 
followed. 

This is the safety alert symbol. It is used to alert you to potential personal injury hazards. 
Obey all safety messages that follow this symbol to avoid possible injury or death. 

 

 DANGER 
DANGER indicates a hazardous situation which, if not avoided, will 
result in death or serious injury. 

 

 WARNING 
WARNING indicates a hazardous situation which, if not avoided, 
could result in death or serious injury.  

 

 CAUTION 
CAUTION indicates a hazardous situation which, if not avoided, 
could result in minor or moderate injury. 

 

NOTICE 
NOTICE is used to address practices not related to physical injury.  

Please Note 

Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material. 

A qualified person is one who has skills and knowledge related to the construction, 
installation, and operation of electrical equipment and has received safety training to 
recognize and avoid the hazards involved. 

It is the end user's responsibility to ensure that any third-party products introduced into a 
solution are assessed for compliance with the security requirements of the solution, and 
that they do not introduce cyber security risks into the solution. 

 



  

Safety Precautions 

 WARNING 
HAZARD OF INCORRECT INFORMATION 

• Do not incorrectly configure the software, as this can lead to 
incorrect reports and/or data results. 

• Do not base your maintenance or service actions solely on 
messages and information displayed by the software. 

• Do not rely solely on software messages and reports to determine if 
the system is functioning correctly or meeting all applicable 
standards and requirements. 

• Consider the implications of unanticipated transmission delays or 
failures of communications links. 

Failure to follow these instructions can result in death, serious 
injury, or equipment damage. 

Notices 

Modbus, Modicon, PowerLogic, Schneider Electric, ION, and ION Enterprise are either 
trademarks or registered trademarks of Schneider Electric in France, the USA, and other 
countries. All other trademarks are property of their respective owners. 

This product must be installed, connected and used in compliance with prevailing 
standards and/or installation regulations. As standards, specifications and designs 
change from time to time, always ask for confirmation of the information given in this 
publication. 

Schneider Electric 35 rue Joseph Monier 92500 Rueil-Malmaison, France 
www.schneider-electric.com 

 



  

The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information that is contained herein. If 
you have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 

No part of this document may be reproduced in any form or by any means, electronic or mechanical, 
including photocopying, without express written permission of Schneider Electric. 

All pertinent state, regional, and local safety regulations must be observed when installing and using 
this product. For reasons of safety and to help ensure compliance with documented system data, 
only the manufacturer should perform repairs to components. 

When devices are used for applications with technical safety requirements, the relevant instructions 
must be followed. 

Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results. 

Failure to observe this information can result in injury or equipment damage. 

© 2014 Schneider Electric. All rights reserved. 
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About The TVD Program 

This document is a [Tested Validated Documented Architecture (TVDA), System 
Technical Note, Tested Validated Documented Solution] Report. A [TVDA, STN. 
TVDS] is one of the documents created as part of the TVD activity. These consist of: 

• TVDA: Tested Validated Documented Architectures 

A Tested, Validated, Documented Architecture (TVDA) provides technical guidelines and 
recommendations for implementing technologies to address your needs and requirements. This 
guide covers the entire scope of the project life cycle, from the Selection to the Operation 
phase, providing design methodologies and source code examples for all system components. 

• TVD - STN: System Technical Notes   

A System Technical Note (STN) provides a more theoretical approach by focusing on a 
particular system technology. These notes describe when to use a particular technology, and 
therefore support you in the Selection phase of a project. TVDAs and STNs are related and 
complementary. In short, you will find technology fundamentals in an STN and their 
corresponding applications in one or several TVDAs or TVDSs. 

“TVD” itself is the set of activities that result in a document or documents that are produced to 
describe how to achieve a goal for an offer or solution. These activities consist of Testing (or 
Verifying), Validating, and Documenting. While these activities are part of normal offer development, 
the difference with TVD is that they are applied with a specific goal in mind; Validation, for example, 
is done specifically to ensure that the goal of the TVD output is possible. Another way of stating this 
is that these activities are narrowly focused to ensure a high standard of quality for the system or 
capability the TVD document describes. 

  

 



 1—Introduction 

1.  Introduction 

1.1.  Purpose 

This document explains how to develop a PowerSCADA Expert device type for the Modbus 

communications protocol. It includes instructions that will aid the implementation of real-time data only 

and does not pertain to the acquisition of alarms or data logs, as they are unique data objects.  

This document is a System Technical Note (STN). It provides a tested, validated and documented set 

of instructions that will enable project execution teams to develop custom Modbus device types for 

Schneider Electric and third-party IEDs. 

On average, the device type setup detailed in this document took four hours to develop. An 

experienced application engineer, who has previously performed the procedure, will develop this 

device type in even less time. 

1.2.  Customer Challenges 

This document is intended to meet the following challenge: 

• As an application engineer, I want a document that guides me through the process of creating 

custom Modbus device types. 

1.3.  Prerequisites 

1.3.1.  System Prerequisites 

Schneider Electric Software 

PowerSCADA Expert version 7.40 Profile Editor  

Operating System and Environment 

PowerSCADA Expert Profile Editor is supported on the following operating systems in both 32-bit and 

64-bit configurations: 

• Windows 7 Professional/Enterprise 

• Windows Server 2008 R2 Standard/Enterprise 

• Windows 8 Professional/Enterprise 

• Windows Server 2012 Standard/Enterprise 

 © 2014 Schneider Electric All Rights Reserved 9 



 1—Introduction 

1.3.2.  Competencies 

This document is intended for readers who have been trained on, or have previously deployed, 

PowerSCADA Expert. In addition, we recommend that you be familiar with: 

• the concepts of Modbus protocol 

• the concepts of power monitoring 

• Microsoft Windows operating systems 

1.3.3.  Preparation 
The reference document(s) for the Modbus device you are integrating needs to be located and 
understood well in advance of working through the Configuration and Implementation section in this 
document.  

 

Determining device reference is the first step in the process of mapping the 
information recorded by the device into a format supported by PowerSCADA Expert. 
The device reference will be necessary to determine the tags that need to be 
configured for the device. See Find the Device Modbus Reference on page 17 
for a full discussion of the device reference. 

 

Communication method for this STN is TCP/IP, but the information also pertains to TCP/IP via a 
gateway. 

1.4.  Glossary 
Term Meaning 

Modbus A serial communications protocol 
CDM (CDMTopics.xml) Common Data Model: used in StruxureWare products to have a 

consistent reference system for data labels and measurements. 
Location: C:\Program Files (x86)\Schneider Electric\PowerSCADA 
Expert\v7.40\Applications\AppServices\bin 

IED Intelligent Electronic Device 

 © 2014 Schneider Electric All Rights Reserved 10 



 2—Selection 

2.  Selection 
This section is intended to help you determine if the Modbus protocol would better meet the 

customer’s needs than other industry protocols. 

2.1.  Selected Architecture(s) 

Modbus, originally created by Modicon for use with its programmable logic controllers, can be applied 

to any market in which remote communications are required. Modbus is the open network protocol that 

is most widely used to establish master-slave/client-server communications. The following graphic 

illustrates a Modbus architecture. 
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 2—Selection 

2.2.  Key Functions 

Advantages of Modbus 

It is highly scalable in scope. A collection of devices using MODBUS/TCP to communicate can scale 

up to more than 10,000 on a single-switched Ethernet network.  

It is simple to administer and enhance. There is no need to use complex configuration tools when 

adding a new station to a Modbus/TCP network. 

There is no vendor-proprietary equipment or software needed. Any computer system or 

microprocessor with Internet style (TCP/IP) networking can use MODBUS/TCP.  

It is very high performance, limited typically by the ability of the computer operating systems to 

communicate.  

 © 2014 Schneider Electric All Rights Reserved 12 



 3—Design 

3.  Design 
This section explains design elements that are key to the function of Modbus protocol 

3.1.  Researching Modbus Support 

For the purposes of correct device type design, you need to consider the following aspects of Modbus 

specification. 

3.1.1.  Data Types 

Data types for Modbus are divided into variables that support monitoring, control, and other functions. 

Within PowerSCADA Expert, tag data types affect the logic codes that are available for display in the 

Edit Address screen. See Logic Codes in PowerSCADA Expert documentation for the data type that 

matches each logic code.  

When analyzing Modbus specification, the following data types can be identified: 

Primary Tables Object Type Type Of 
Discrete Input Single Bit Read Only 
Coils Single Bit Read-Write 
Input Registers 16-bit Word Read Only 
Holding Registers 16-bit Word Read-Write 

Table 1: Modbus Data Types 

The various object types can be represented in the following forms: 

• Boolean 
• String 
• Integer 
• Floating Point 

Identification of the data type is necessary to integrate the device with PowerSCADA Expert. 

Depending on the device documentation, the data type may be specified using any of the above 

criteria. Use the information you have available to determine the data type, and use the PwrModbus 

Driver help file. (In the Citect Project Editor menu, click Help > Driver help) From the Contents pane on 

the left, locate PwrModbus Driver. 

 © 2014 Schneider Electric All Rights Reserved 13 
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 3—Design 

Example 1 

Description Valid 
Function 

Codes 

SET_M Point 
Label/Enums 

Number of 
16-Bit 

Registers 

Min Value Max Value Scaling 

(X1 unless 
specified) 

Three-phase 
reactive 
power 

03, 04 KVAR3 2 –21474883648 2147483647 — 

Phase A 
Power Factor 

03, 04 PFA 1 –100 100 100 

Phase B 
Power Factor 

03, 04 PFB 1 –100 100 100 

Phase C 
Power Factor 

03, 04 PFC 1 –100 100 100 

Three-Phase 
Power Factor 

03, 04 PF3 1 –100 100 100 

Phase A PF 
Loading 

03, 04 LDPFA 1 0 1 — 

 

The table above contains power measurements from a third-party Modbus specification. Note that: 

• The Description column lists the available measurements. 
• The valid function codes are an industry standard depending on the type of register. 
• Profile Editor help contains all the necessary function codes available for use and a description that 

should help with selection of the right one for desired measurement.  
• In most cases, the scaling factors in Profile Editor should not be changed. 

3.2.  Designing Tags to Support Full PowerSCADA Expert Functionality 

One of the key considerations when creating Modbus drivers is whether you need the data used in the 

following components in PowerSCADA Expert: 

• Reporting 
• LiveView (available in version 7.4) 
• PowerSCADA Expert Breaker Graphics 

Data will not appear in these components unless the tags in the driver are compliant with the CDM, or 

Common Data Model (see 1.4 Glossary for location). The CDM is designed to enable different 

devices to use the same data. Newer components in PowerSCADA Expert also access the CDM 

mappings in order to present data. The Configuration and Implementation section describes the steps 

involved in ensuring that tags are ”known” by the CDM. 

Data that is stored in tags not contained in the CDM will still be accessible for real-time display, 

graphics, trending, alarms, and other legacy PowerSCADA Expert components. 
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Examples of noncompliant tags you might encounter include the following, which are hardcoded into 

equipment popups. Failing to correctly address these tags will render the entire standard library of 

genies unusable. 

• Breaker position 
• Breaker racked out position 
• Breaker Earth switch position 
• Matching fault / trip circuit supervision 
• Trip status 

 © 2014 Schneider Electric All Rights Reserved 15 
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4.  Validation 
This section includes information about the lab setup used to test the STN. 

4.1.  Validation Environments 

Stage Environment Validation focus 

Lab Validation LaVergne Lab Device type creation 
TVD Writing Virtual machines Device type creation 
Pre-validation Virtual machines Document itself 
Final Validation Virtual machines Document itself 

4.2.  Time to Deploy 

The time required to develop custom Modbus device types will vary depending on configuration. Other 

variables include the need to add or modify entries within CDMTopics.xml, which is typically located in 

the root drive under C:\Program Files (x86)\Schneider Electric\PowerSCADA 

Expert\v7.40\Applications\AppServices\bin. 

4.3.  Reviewers 

Lab validation and TVD writing were completed by engineering staff. Pre- and final validation was 

performed by Customer Care Center (i.e., technical support) and Partner training. 
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 5—Configuration and Implementation 

5.  Configuration and Implementation 
This section explains how to configure PowerSCADA Expert to integrate with a Modbus device, and 

how to subsequently connect with the device. 

5.1.  Find the Device Modbus Reference 

The first step in configuring the driver, as mentioned in the Prerequisites section, is to find the Modbus 

reference. The manufacturer should have a document with a table listing the data types. After you find 

the reference, familiarize yourself with the manner in which the Modbus objects are explained. This will 

expedite the rest of the commissioning. 

The following tables come from the SEL-351S specification. In particular, we will be looking at the 

Reclosing Relay Reset Modbus register for this device.  

Table D.2: Alphabetic List of Relay Word Bits (sheet 6 of 13) 

Name Description Usage Row (Table D.1) 
79RS Reclosing relay in the Reset State Control 35 

Table 0.23: Default Modbus Map (sheet 2 of 2) 
Modbus 
Address 

User Map Register Mapped Register 
Label 

Notes 

041 MOD_042 ROW_35 Contains 79RS, 79CY, 79LO 

Table D.1: Relay Word Bit Mapping (sheet 2 of 5) 
Row Relay Word Bits 

35 79RS 79CY 79LO SH0 SH1 SH2 SH3 SH4 

5.2.  Use the Modbus Help File 

After you locate the reference and understand how the specification is structured, you can obtain an 

initial confirmation that the data type is supported by PowerSCADA Expert. To do this, locate it in the 

Modbus help file.  

Example: Relay Recloser Reset Control is a 16-bit register with bit mask 79RS at the 8th bit from the 

right. In the Modbus Driver help file, we find that this is addressed as shown in Table O.23 (see 

above), using register 42. To access the Modbus Driver help file: In the Citect Project Editor menu, 

click Help > Driver help. From the Contents pane on the left, locate PwrModbus Driver. 

 © 2014 Schneider Electric All Rights Reserved 17 
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5.3.  Creating the Device Type 

The first step in creating a device type is to create a new device: 

1. Open the Profile Editor. In the Define Device Type Tags tab, click Add/Edit. 

2. Select Create New, name the Device Type, and select Generic Power Device as the driver.  

 

5.4.  Selecting the Tags 

As mentioned in the Design section, it is important to select CDM-compliant tags in order to support 

the full functionality of PowerSCADA Expert. To do this: 

1. Locate the “best fit” tag from the tag library. 

2. Reference the CDMTopics.xml file (typically located in the root drive under C:\Program Files 

(x86)\Schneider Electric\PowerSCADA Expert\v7.40\Applications\AppServices\bin) to ensure that 

the tag is referenced. 

5.4.1.  Finding the Best Fit from the Tag Library 

The tag library contains many labels for common topics. The challenge is to find the tag that best 

represents the quantity being measured by the 

meter. The tags in the tag library are grouped in a 

manner that aids look-up, but you may need to 

perform additional research into the manner in 

which the device records the quantity. 

5.4.2.  Verifying the CDM reference 

After you locate the tag that you think is correct, open the CDMTopics.xml file, which is typically 

located in the root drive under C:\Program Files (x86)\Schneider Electric\PowerSCADA 

Expert\v7.40\Applications\AppServices\bin. Look for the same label in the <DisplayName> element. 

 © 2014 Schneider Electric All Rights Reserved 18 



 5—Configuration and Implementation 

 

If you find it, you have verified that the tag you have chosen will be supported by all of the 

PowerSCADA Expert components. If you do not find it, look for similar tags in the CDMTopics.xml file: 

check the <DisplayNames> there against the list of topics in Profile Editor to find a best fit 

If necessary, you can create a new measurement by copying any other measurement in 

CDMTopic.xml from <CdmTopic> to </CDMTopic> and pasting it at the end of the xml file. You can 

then customize it as desired.  

 

Repeat this process for all of the tags, and then Save and Exit to return to the main 
Tag Definition screen. 

5.4.3.  Configuring the Modbus Tags 

You need to edit the addresses of the tags to map them to the Modbus register of the device. The tags 

you have selected will display in red to indicate that they need to be configured. 

 

To configure the tags, do the following: 

1. Click Edit for the tag you want to edit. 

2. Fill in the Address field as per the instructions in the Profile Editor help file. Pay attention to the 
logic codes and bit masks, if they are needed.  

 © 2014 Schneider Electric All Rights Reserved 19 
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3. If you are using an existing measurement, the data type will be pre-selected. 

4. Pay attention to the Logic Code; there can be many selections available. To find the right code, 

refer to Profile Editor Help and search for logic codes. In this instance, Status SS would be the 

desired Code as SS = Single Status (0 or 1).  

 

 

Repeat this process until all tags are configured, and then proceed to creating the 
Device Profile. 
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5.5.  Creating the Device Profile 

In the Create Device Profiles tab,  

1. Click Add/Edit; from the Options, click Create New. Click Next. 

 

2. Name the new Device Profile. 

 

3. Move the Device Type into the Selected Devices pane. Click Next. 
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4. Move all of the tags into the Selected Tags pane. Click Next 

 

5. Select Trending for all tags that require it. Click Finish. 

5.6.  Setting up the Project and Exporting the Profile  

1. In the Profile Editor menu, select File > Export 

2. Make sure PowerSCADA Expert Export is checked. 

3. Select “Set Up Projects” tab. 

4. Select the project on which you are working. Click “Add / Edit”. 

 

5. Add the device profile to the Selected Device Profiles. 
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6. Click Save and Exit. 

 
7. Export the Project. 
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When the expot is complete, you see the Export Summary. 

 

5.7.  Importing the Modbus Profile 

You need to bring the profile into your project. 

1. Launch the Profile Wizard and select the Create an I/O Device option. 

 

2. Select the Modbus profile. Click next. 

 

3. Name the device. 
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4. Select the communication method and configure the communication parameters. 

 

 

 

5. You are now ready to add the device. 
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6.  Conclusion 
The key to custom Modbus device type creation is planning ahead and understanding both the device 

and application. You must: 

• Identify and understand your device’s Modbus reference. 
• Refer frequently to Modbus driver documentation for questions on register mapping. 
• If Reporting or LiveView functionality is a requirement for your project, verify that tags have an 

appropriate entry in the CDMTopics.xml (typically located in the root drive under C:\Program Files 
(x86)\Schneider Electric\PowerSCADA Expert\v7.40\Applications\AppServices\bin). 

If you have comments or suggestions about the contents of this document, please contact your 

business development representative and ask that they be relayed to the PowerSCADA Expert team. 
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7.  Appendix 

7.1.  Supplemental Information and Reference 
Document or Reference Link or Location 

PwrModbus Driver Help .CHM file (In the Citect Editor menu, click Tools > 
Computer Setup Editor. In the Computer Setup Editor, click 
Help > Driver Parameters. From the Contents pane on the 
left, locate MODBUS Driver.) 

Schweitzer SEL-315S 
Instruction Manual 

Provided with device 

7.2.  Connecting to Your Device 

The following brief troubleshooting guide may help you connect to your Modbus devices. 

• If your device is multi-protocol, verify that the device is set to communicate Modbus via TCP/IP. 
This is typically located in the hardware setup interface (e.g., IONSetup or SFT2841). 

• Verify the port before running the device wizard. In our example, the default Modbus port for 
communication is 502. 

• Verify and configure the device’s default slave identification if it is to use a gateway. In our 
example, our SEL meter had no specific slave identification using only an IP address.  

• Additional information regarding debug troubleshooting can be located in the “Troubleshooting” 
section of the Modbus driver documentation. 
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